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Basic Unit 1

Chapter 1: Basics of Robotics

What is a robot?

When it comes to robots, many people will think
of humanoid machines with hands and feet.
However, this kind of machines tends to appear
only in science fiction movies, entertainment
venues, exhibitions and toy stores. They are very
different from industrial robots.

The definition of a robot

A robot is officially defined by the Robot Institute
of America in 1979 as 'a re-programmable, multi-
functional manipulator designed to move
materials, parts, tools, or special devices through
variable  programmed  motions  for the
performance of a variety of tasks'. As long as a
machine satisfies the criteria, it can be called a
robot even if it does not have a
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Basic control of electronic components

Industrial robots (IRs), sometimes called robotic
arms, can perform simple actions such as up-and-
down motions, and grab and pick out components
from machines. However, industrial robots can
also perform more complicated tasks such as
transportation, gripping, targeting, assembly and
inspection.

human form.

An industrial robot, which is usually referring to
a robotic arm, consists of several links connected
in series by linear, rotary or prismatic joints. At
one end, the robot is fixed to a supporting base,
and the other end is equipped with a tool and
manipulated into position to perform tasks.



Nowadays, robots are becoming popular for
entertainment purposes and even for innovative
technologies, such as those related to human life,
animals and military purposes.

Design of industrial robots

Mechanical engineering
Interaction with the environment

Computer science
Autonomous judgment

Therefore, a robot can also be defined as ‘a human
made semi- or fully autonomous (self-controlled)
object or cooperating objects (with common
objectives)  with  intelligence  that is
programmable’.

Industrial robots are made up of six basic constituent elements, which are: the dynamic system, end-of-
arm tools, computerised digital controller, actuators, feedback devices and sensors.

The following diagram shows the inter-relationship between these six elements:
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Microcontroller O

‘ Feedbay

Robotic arm

Initially we upload the program to the
microcontroller, which will then react to give
corresponding outputs, for example to the robotic
arm and the end effector. The microcontroller
controls the various joints and the rotational base
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Linkages
(Equivalent to the
human arm)

4 End-of-arm tool
(Equivalent to the
human hand)

(Equivalent to the
human joint)
Rotational base
(Equivalent to the
human body)

Targets

flexibly to perform high-precision actions and
specific work goals. Then, the sensors of the robot
will return some readings to the microcontroller.
Finally, the microcontroller acts accordingly to
achieve the work goals.



IVV. Development of robots and advancement of robotics

Robots have become popular, and advanced technologies have been
developed, such as the da Vinci surgical system, the robots sent to Mars by
NASA for exploration, and the open source project Arduino.

Robots were no longer limited to the industrial area and have penetrated into all aspects
of society, such as military use, entertainment, and imitation of humans and animals.

The intelligence of robot has been developed to a level where robots can perform
intelligent activities such as playing chess and interacting with animals.

The era of mass production of robots. Different countries began to
design robots themselves and microprocessors were invented.

The beginning of modern robots. Artificial intelligence laboratories were set up by advanced
international universities and the first computer-controlled robotic arm was born.
I
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Before 1950, robots were only characters in
science fictions. 1960 marks the beginning of
modern  robots. Acrtificial  intelligence
laboratories were set up by advanced international
universities such as the Massachusetts Institute of
Technology. The first computer-controlled
robotic arm was born during this period of time.
From 1970, the world officially entered the era of
mass production of robots. Different countries,
especially those in Europe, began to design robots
themselves. Microprocessors were also invented
during this period of time. In 1980, scientists
made a breakthrough to the bottleneck of robot

Review questions

What is a robot?
What elements does robotics include?

ok wnE
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development, where robots were developed to
possess their own intelligence such that they can
play chess or interact with animals. In 1990,
robots were no longer limited to the industrial
area and penetrated into all aspects of society,
such as military use, entertainment, and imitation
of humans and animals. In 2000, robots have
become popular, and advanced technologies have
been developed, such as the da Vinci surgical
system, the robots sent to Mars by NASA for
exploration, and the birth of the open source
project Arduino.

What are the basic components of the design of a robot?
Can you describe the entire operation of a robot?
Can you give an overview of the development of robots?



Chapter 2: What Is Arduino?
I.  Understanding microcontrollers

Simply speaking, a microcontroller, MCU, is
indeed a tiny computer containing a processor,
memory, input/output units and other peripheral
devices that is installed in a single integrated
circuit. However, a microcontroller does not have
a built-in operating system and thus it cannot
operate like a computer. Programs need to be
developed on other computer systems before they
can be input to it.

I1. Various microcontrollers

The core of most early microcontrollers adopts
Atmel AVR series developed by Atmel in 1996,
which is a family of 8-bit to 32-bit automatic
control reduced instruction set microcontrollers.
AVR uses flash memory as the data storage
medium for its single-chip microcontrollers, as
opposed to one-time programmable ROM,
EPROM, or EEPROM used by other
microcontrollers at the time. The following are a
few common microcontrollers.

Arduino UNO

The microcontroller that will be
used in this teaching resource.
The entry barrier for this
development board is low, and is
easy for non-professional people
to learn and use.

Intel Galileo

Famous computer processor
manufacturer Intel has also
developed microcontrollers.
The characteristic of this
development board is that it has
pin positions compatible with
Arduino UNO, and can be
programmed with Arduino IDE.

= B 09 H25321-400
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Nucleo 64

The Nucleo development board
consists of a 32-hit
STMicroelectronics
microprocessor, which has a higher
processing power than Arduino,
but is harder to use in comparison
with Arduino.

P www.st.com/stm32nucleo

Udoo Dual

This is a development board that
can load Windows 10 10T. Itis
more powerful than Arduino
UNO but more difficult to
program.

BeagleBone Black

This is a microcontroller
development board produced by
Texas Instruments in association
with Digi-Key and Newark
element14, which was released
in 2011.

elementiy
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V1. What is Arduino?

Arduino was an assignment given to students of
the lvrea Interaction Design Institute in Italy in
2005, aiming to provide a low-cost, easy-to-use
interface for students, amateurs or professionals
to design interactive devices that consist of
sensors and drivers.

Arduino is a computer control board that uses an
Atmel AVR single-chip microcontroller. It can be
connected to various input and output devices,
and can be connected to a variety of
communication modules. With suitable control
programs, a wide range of automatic control
applications can be made, for example,
controlling the rotation speed of a fan according
to the temperature, controlling the brightness of a
light or the speed of a motor with a variable
resistor, remote controlling home appliances with
infrared or Bluetooth, controlling a robotic arm or
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robot with servo motors, and producing automatic
vehicles and aircraft.

The most prominent feature of Arduino is that
both its software and hardware are open-source.
Traditionally, it is a prerequisite for the developer
to possess a background in disciplines such as
electronic or electrical engineering in order to
develop a microcontroller program, which is not
at all easy for ordinary people to take part in.
Arduino has a low entry barrier, and is easy for
ordinary people to learn and use. Furthermore,
there are a lot of Arduino resources on the Internet
to which people can refer, and as a result, they can
complete their own works in a short time by
adjusting the design according to their needs.

Circuit design diagrams of Arduino can be
downloaded from the Internet, and there are
reasonably priced Arduino control boards
available for sale on the Internet.



IV. Arduino control boards (hardware)

Programming by connecting to a computer via USB

Arduino can be connected to a computer with the universal USB connection to facilitate users to write
programs.

Online programming
Arduino uses an online programmer to load the boot loader to the control panel. It guides the operating
system to initiate the program, which has the following advantages:

1. Simplify the programming process
2. Initiate when running the user's program
3. Inspect the solution on the development platform

The following diagram shows the various components on an Arduino control board, and the various
input and output pins available.

ICSP pin  Digital output and input pins
Reset button SCL SDA 1

s N ; o m—on o ICSP pin
o : Anouruo

ATmegal6U?2 6

MADE IN ITALY

DC voltage 3 SHIE o

regulation . olol e ., e gy

module

ATmega328

7 ~ 12 V power input \—1——-'
socket (1::,5 g:lz quartz Analogue input pins (can
y also be used as digital
output and input pins)

V. Review question
1. What is Arduino UNO?

Basic Unit 1: Basic control of electronic components 10



Chapter 3: Arduino IDE (Software)
I.  Program installation and connection between the hardware and the software

Arduino IDE is the programming platform and environment for Arduino. A lot of different programming
software can be used for Arduino but Arduino IDE that can be downloaded from arduino.cc will be
focused in this teaching resource.

Download the Arduino IDE

Windows inszal
Windows

E

ARDUINO 1.8.5

ARDUINO Windows app

Mac 0 X107 Lion or newer

Linux 32 bits
Linux 64 bits
Linux ARM

WHAT IS

sed with any Arduino board.
Started page for nstallation

BETA BUILDS

-

BUY AN ARDUI

LEARN ARDUIN

the Arduino I0E with
‘experimentalfeatures. This versien should NOT be used in
uction.

updated features and busgfxes.

Windows

Mz 05 X (Mac OSK Lion of lter)
Linux 32 it Liux 64 bt Lintix ARM

DONATE

®
. A POWERFUL BOARD
o ARDUINO
e NI

Arduino IDE can be downloaded from www.arduino.cc

] n Application Tools [ELCILES
File Home Share View Manage ~ ©
& Cut I New item ~ W] Open - FH Select all
O 4 X = ‘ hd
W= Copy path f ] Easy access * Edit Select none
Pinto Quick Copy Paste >, Move Copy Delete Rename New Properties q "
access [#] Paste shortcut tov tov > folder £ & History [ Invert selection
Clipboard Organize New Open Select
& v > This PC > Acer (C:) » Program Files (x86) > Arduino v L  Search Arduino »p
n" o
= 0 s 5
! -~ - -
»
drivers examples hardware java lib libraries reference
%]
- ‘ » ‘ »
o - 8”
tools tools-builder arduino.exe arduino.l4.ini arduino_debug.  arduino_debug.|  arduino-builder.
< exe 4j.ini exe
: @
p g
“ v
»
M libusb0.dll msvep100.dil msvcr100.dil revisions.txt uninstall.exe wrapper-manife
st.xml
B
L]
v
20items  1item selected 395 KB -

Arduino installation file
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Il.  Arduino IDE layout

1. Layout introduction

old setup
// put your setup code here, to run once: Toolbar
}
void loopQ) { Code writing
// put your main code here, to run repeatedly: area
}
Message

area

Arduino/Genuino Uno §% /dev/cu.Bluetooth-Incoming-Port

2. Descriptions of the toolbar buttons:

Verify: Qhecks your code for errors before compiling it.

Upload: Compiles your code and uploads it.

New: Creates a new sketch (a program written using Arduino IDE).
Open: Presents a menu of all the sketches in your sketchbook.

Save: Saves your sketch.

Serial Monitor: Opens the serial monitor for communicating with
the Arduino via the serial port.

Basic Unit 1: Basic control of electronic components 12



I11. Do it yourself — Understanding Arduino & Arduino IDE

This section is for students to familiarise
themselves with the operation of the Arduino
control board and Arduino IDE. For the computer
to communicate with the Arduino control board,
we must use the serial port. However, modern
computers generally use USB ports and thus
cannot communicate with the Arduino control
board directly. To handle this, we need to use a

ATmegal6U?2

USB-to-serial chip, commonly used types
including ATmega8U2, CH340, CP2102,
FTDI232R and PL2303. The official version of
the Arduino control board contains an
ATmegal6U2 USB-to-serial chip, which can
facilitate us to use the computer to communicate
with the Arduino control board and burn

programs.

This exercise uses the on-board LED of the Arduino, and does not need to connect to external units.

1.  Open Arduino examples - LED Blink: Click File > Examples - 01.Basics - Blink.

Eile Edit Sketch Tools Help
New Ctrl+N
Open... Ctrl+0
Open Recent
Sketchbook

Basic Unit 1: Basic control of electronic components

Examples Built-in E ‘

uilt-in Examples
Close Ctrl+W o : AnaloaReadSeria
swe  cubs — AnslogReadsei

.Digita areMinimum
Save As... Ctrl+Shift+S < .

03.Analog Blink
Page Setup  Ctrl+Shift+P 04.Communication DigitalReadSerial
Print Ctrl+P 05.Control Fade

06.Sensors ReadAnalogVoltage
Preferences Ctrl+Comma )

07.Display >
Quit Ctrl+Q 08.Strings >

Py
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1. The following program will appear after clicking Blink.

Blink §

24

25 // the setup function runs once when you press reset or power the board
26 void setup() {

27/ imitialize digital pin LED_BUILTIN as an output.

28 pinMode(LED_BUILTIN, OUTPUT);

291

31 // the loop function runs over and over again forever
32 void loop() {
33 digitalWeite(LED_BUILTIN, HIGH);  // turn the LED on (HIGH 1s the voltage lewel)

34 delay(1008); S/ walt for a second

35 digitalWrite(LED_BUILTIN, LOW); £/ turn the LED off by making the woltoge LOW
36 delay(1008); S/ walt for a second

7%

L L L

(4]

This program consists of two main parts. In the first part, the code inside the setup( ) function
configures the Arduino’'s on-board LED as an output (OUTPUT). In the second part, the code
inside the loop( ) function turns the on-board LED on and off continuously.

3. Then plug in the USB cable to connect the Arduino control board with the computer.

Basic Unit 1: Basic control of electronic components 14



4.  After connecting to the computer, we must first open the Control Panel of the computer > Device
Manager to find the Communications Port (also known as Serial Port) of the Arduino board. The
figure below shows the Communications Port (COM9) of the Arduino UNO found in the Device

Manager.

=y Device Manager

=

File Action View Help
&= @ E HBml 8 2SS

4.23) LAPTOP-S8TCEOEMT
> - Computer
I g Disk drives
| [» -‘,‘, Display adapters
b -4y DVD/CD-ROM drives
B> Eﬁ Human Interface Devices
fl I =gy IDE ATA/ATAPI controllers
|» == Keyboards
I - JF Mice and other pointing devices
B> l,-y Monitors
I -¥ Network adapters
4 Y57 ports (COM & LPT)
- Arduino Uno (COM9)
[» n Processors
() Sound, video and game controllers
> -l System devices
P a Universal Serial Bus controllers

5. In Arduino IDE - Tools—> Board: - select Arduino UNO development board.

File Edit Sketch Tools Help

Auto Format Ctrl+T
Archive Sketch

Blink Fix Encoding & Reload
Serial Monitor Ctrl+Shift+M

Serial Plotter Ctrl+Shift+L

04 /] the WiFi101 Firmware Updater

g A Board: "Arduino/Genuino Uno" :
vold s o/G Boards Manager...
) Port Arduino AVR B is
26 f‘ I 1 Get Board Info Argd .l!ml AV oaras
Arduino Yun
pinM  Programmer: "AVRISP mkil* >[® Arduino/Genuino Uno
8 ) Burn Bootloader Arduino Duemilanove or Diecimila

Arduino Nano
Arduino/Genuino Mega or Mega 2560

you press reset or power the board

6. In Arduino IDE, select the Communications Port of the Arduino UNO found in the Device Manager

above.

File Edit Sketch Tools Help

Auto Format Ctrl+T
Archive Sketch

sketch_mar04z Fix Encoding & Reload
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: Serial Monitor Ctrl+Shift+M A
void setup() {
Serial Plotter Ctrl+Shift+L
{1 put your
WiFi101 Firmware Updater
! Board: "Arduino/Genuino Uno" >]
. Port 5 Serial ports
wold Toop() 1 Get Board Info | COMS (Arduino/Gen
/¢ put your —
Programmer: "AVRISP mkil" >
} Burn Bootloader
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7. Press the Upload button. The program will be compiled and uploaded to the Arduino UNO
development board.

Elink &
24
25 // the setup function runs once when you press reset or power the board
26 void setup() {
27 /4 initialize digital pin LED_BUILTIN as an output.
28 pinMode(LED_BUILTIN, OUTPUT);
291
30
31 // the loop function runs owver and over agailn forever
32 void loop() {
33 digitolWrite(LED_BUILTIN, HIGH); // turn the LED on (HIGH is the voltage lewel)

34 delay(1000); A5 wait for a second

35 digitalWrite{LED_BUILTIN, LOW); 4/ turn the LED off by making the wvoltoge LOW
36 delay(1600); A7 wait for o second

373

8.  When the upload is done, you should see the Arduino's on-board LED begins to blink.

LED

ANALOGIN

o < oW

IV. Review questions

1. What is Arduino IDE?
2. How to connect the Arduino control board to the computer, and make them communicate?

Basic Unit 1: Basic control of electronic components 16



Chapter 4: Control (I) - LED Control

I. Light-emitting diode, LED

A light-emitting diode is the most basic and
commonly used output device. Its illuminating
property can be used to indicate the status, for
instance, the lighting up of a green LED and a red
LED can be used to indicate a qualified condition
and an unqualified condition respectively. In
addition, it can be used for program testing. As
a program is executed from top to bottom, if we
would like to test whether a part of commands has

Anode
(+)

An LED is a kind of unidirectional hardware, i.e.
we need to connect it according to the current of
a circuit; otherwise, it will not lightup. An LED
usually has two leads, one long and one short. The
long one is called the anode and the short one is
called the cathode. The direction of the current
should flow from the anode to the cathode.

Basic Unit 1: Basic control of electronic components

been executed, we can add some codes under that
part of commands for flashing an LED. If the LED
flashes, it means that part of commands has been
executed. Furthermore, we can test the strength of
a signal. For example, we can use the received
signal as the brightness of the LED. Then we can
judge the signal strength with the naked eye. We
can use LEDs and programming to carry out all of
the above functions

Cathode
(-)

Since LEDs have a small size, do not heat up and
are more robust, in contrast to traditional light
bulbs that are solely used for lighting, LEDs are
widely used as the signal indicators of electronic
products. In this section, the LEDs we are going
to use are commonly seen small LEDs with a
range of colour choices such as red, orange,
yellow, green and blue.

17



Il. Different parts of an Arduino program

File Edit Sketch Tools Help

rQ
Blink
Turnz on an LED on for one second, chen

Mozt Arduinos have an on-bosrd LED you
Leonardo, it i3 attached to digital pin
pin the on-board LED iz connected to on
the documentation at hrtp: /facduing. cc

Thiz example code i3 in the public doms
modified & May 2014

by Scott Fitzgerald
)

off for one second, repeatsdly.
can control. On the Uno and

13. Tf you're unsure what
your Arduino wodel, check

in,

// the setup function runs once when you
woid setup () {

pinMode (13, OUTPUT)
}

4/ initialize digical pin 13 a2 an ourput.

pES3 reset or power the board

Lhe loon f: Iups over and over a
woid loop() {

gain forewer

delay(1000) walt Lor &

I11. Different parts of a functi

digitalVWrite (13, HIGH) I,r’f turn the LED on (HIGH iz the woltage level)

Teconyg

digitalVrite (13, LOW): the LED off by making the voltage LOW
delay(1000); i/ walt for
3

on

Content between /* and */ is the remark
written by the programmer which will not
be executed.

Setup(): a function that will be executed
once. Pin 13 is configured as the output pin
here.

Content after // will not be executed also.

4

Loop(): a function that will be executed
over and over again until the power is cut
off.

Different parts of a function written in C/C++ programming language.

All commands of a
function need to be
placed between { and }

Output of the function: 'void' means no output

Name of the function

Input of the function: () means no input

void setup() {
pinMode(13, OUTPUT);

}
void loop( ) {

digitalWrite(13, HIGH);
delay(1000);
digitalWrite(13, LOW);
delay(1000);

Basic Unit 1: Basic control of electronic components

The command that a function
needs to complete should end
witha'',e.g.a=a+b;

// turn the LED on
// wait for a second
// turn the LED off

// wait for a second

18



pinMode(13, OUTPUT);

pinMode — calls the function to define the mode of the pin.  The function first specifies the pin number
(1~ 13 or A0 ~ Ab), followed by the action (INPUT, OUTPUT or INPUT_PULLUP). INPUT: input;
OUTPUT: output; INPUT_PULLUP: enables the pull-up resistor of this pin and provides a stable 5V
voltage.

digitalWrite(13, HIGH);

digitalWrite — Calls the function to define the pin as a digital output to be written with a 5V or 0V
value. The function first specifies the pin number (1 ~ 13 or A0 ~ A5), followed by the write action
(LOW or HIGH). HIGH: high electric potential (5V); LOW: low electric potential (OV).

delay(1000);

Delay — Calls the function to define a delay time of 1000 ms (must use milliseconds (ms) as the unit).

Throughout the programming process, we will need to record some data, which may be text or numbers.
We record these data at an address in the memory and give them names. These are variables. The
following are some variables commonly used in Arduino programs.

Memory size
boolean 8 bit (1 byte) 1or0
byte 8 bit (1 byte) 0 ~ 255
char 8 bit (1 byte) —-128 ~ 127
int 16 bit (2 bytes) —32768 ~ 32767
long 32 bit (4 bytes) —2147483648 ~ 2147483647
float 32 bit (4 bytes) +3.4 e+ 38

Basic Unit 1: Basic control of electronic components 19



IV. Do it yourself — LED blink

The first task of this chapter is to try to control the blinking of an LED with the Arduino. There are two
parts in this task, which are to connect the Arduino with the LED and to program the Arduino to control

the LED.
1 Connecting the Arduino and the LED

We connect the LED, resistor and the Arduino as follows.

220 ohm resistor

Not many electronic parts are required for this
task and the connection method is very simple.
First, we attach ared LED to a breadboard. Note
that the leads of an LED are different in lengths.
The longer one is the anode and the shorter one is
the cathode. To light up an LED, the current must
flow from the anode to the cathode. Therefore,
when the LED is on, the anode must be at a high

potential and the cathode must be at a low
potential. In this task, the anode and cathode of
the LED are connected to pin 13 and GND
(ground) of the Arduino board respectively. A
resistor is connected between the LED and the
Arduino board for limiting the current flowing
through the LED, so that there will not be
overcurrent affecting the operation of the LED.

e e eee—=——— 25 connected nodesin a

horizontal row

mmmmmmmmmmmmmmm

FEORND @@ O e N
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Understanding a breadboard:

A breadboard allows connection of electronic components used in a circuit with no soldering required.

1. Power rails: The breadboard shown in the
above figure has two rows of holes at the top
and bottom respectively. They are generally
used for providing power supply. The row
marked with '+' at the top has 25 interconnected
holes and all of them are positive pole. The
second row at the top marked with - is for
connecting to the ground. The first and second
rows at the bottom have the same configuration
as those at the top of the breadboard.

2. Terminal strips: The connection holes on the
breadboard shown in the above figure are
divided into upper and lower parts, which are
the main working area for connecting the
electronic components and jumper wires. The
five holes in the same vertical column (i.e. a-b-
c-d-e or f-g-h-i-j) are interconnected. However,
there is no connection between the vertical
columns (i.e. 1-30), and between the upper and
lower parts of the ravine (i.e. e-f).

2 Programming the Arduino to control the LED

Open Arduino IDE and connect the Arduino to the computer.

Select Arduino UNO as the development

board in the Tools menu and check whether the Communications Port is connected to the Arduino

already.

File Edit Sketch Tools Help

Auto Format

Archive Sketch

Fix Encoding & Reload
Serial Monitor

Serial Plotter

Ctrl+T

Blink
Ctrl+Shift+M

Ctrl+Shift+L

WiFi101 Firmware Updater vou

Board: *Arduino/Genuino Uno"
Port
Get Board Info

Programmer: "AVRISP mkIl*
5 ) Burn Bootloader

Sevoid s : Boards Manager...
Arduino AVR Boar
Arduino Yun
*/ @ Arduino/Genuino Uno
Arduino Duemilanove or Diecimila
Arduino Nano
Arduino/Genuino Mega or Mega 2560

press reset or power the board

ds

After connecting the Arduino, we need to input the following program and upload it to the Arduino.

The complete program codes.

int ledPin = 13;

J =

J O . SN BN B NN N BN BN NN BN B N

vold setup() {
pinMode(ledPin, OUTPUTD;

L= LWy I N |

vold loop() {
digitalWrite(ledPin, HIGH);
delay (10087 ;
digitalWrite(ledPin, LOWD);
delay (10087 ;

(=l s R |

o~

F
M=Jd |
[
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Refertofile1 4 1 led flash.

Define the variable

Define the pin for
the LED

Set the blinking
frequency of the LED
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3 Program content explanation

1. Define the variable
1 int ledPin = 13;

The program is divided into three parts. In the first part, we define variable 'ledPin’ to be an integer 13.
An integer is one of the data types in a program. To define an integer variable, we need to add 'int'
before the variable.

2. Define the pin for the LED

3 wold setup(d {
4 pinMode(ledPin, OUTPUT);
51

In the second part, we define the pin of the Arduino that is connected to the LED. In the previous part,
variable 'ledPin’ is defined as integer 13. In this part, we use ‘pinMode ()' to define pin 13 as an output

pin.

3. Set the blinking frequency of the LED

7 wold loop() {

8 digitalWrite(ledPin, HIGH};
9 delay(10087,;

1@ digitalWrite(ledPin, LOW);
11 deloy(1008);

12 %

Assuming that the LED blinks once every two seconds, that means the time the LED is set to turn on
and off is one second each. We use 'digitalWrite()' in the program to control the LED: when 'digitalWrite'
is set as HIGH, the LED turns on; when 'digitalWrite' is set as LOW, the LED turns off. 'delay()' is
used to pause the program for a specific amount of time (in milliseconds). There are 1000 milliseconds
in a second.

4. When the program is uploaded to the Arduino UNO, the red LED on the breadboard will turn on
for one second and off for the next, and repeat over and over.
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V. Do ityourself — Traffic light

The second task of this chapter is very similar to the first one. In this task, we will try to control three
LEDs of different colours to light up one after another, imitating the traffic lights we often see in our

daily life.
1 Connecting the Arduino and the LEDs

We connect the LED, resistor and the Arduino as follows.

Ty . et
pxmm  Arduino

The way to connect the LEDs in this task is the same as that in the first task. The anodes of the LEDs
are connected to the Arduino and the cathodes are connected to GND. Since there are three LEDs to be

controlled in this task, we need to use three pins on the Arduino to connect the LEDs, which are pins 11,
12 and 13.
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2 Programming the Arduino to control the traffic light

Open Arduino IDE and connect the Arduino to the computer. Select Arduino UNO as the development
board in the Tools menu and check whether the Communications Port is connected to the Arduino
already. After connecting the Arduino, we need to input the following program and upload it to the
Arduino.

The complete codes of the traffic light program. Refer to file 1 4 2 traffic_light.

1 int ledPin_R = 13; ‘ '
2 int ledPin_Y = 12: Define the variables
3 int ledPin_G = 11;

'1 —————— W N N SN SN S B A N S S S S R - -

SEvoid setupl) {

pinMode(ledPin_R, OUTPUT):

pirMode(ledPin_Y, OQUTPUT); Define the pins
& pinMode(ledPin_G, OUTPUT); for the LEDs

=] N

l1gvoid loop() {
12 digitalWrite(ledPin_R, HIGH):
13 delay(100@);
14  digitalWrite(ledPin_R, LOW);
15 digitalWrite(ledPin_Y, HIGH):

16 delay(1000); Set the bllnklng

17 digitalWrite{ledPin_Y, LOW): sequencg and
18 | digitalWrite(ledPin_G, HIGH); frequencies of
19 delay(10ea); the LEDs

20 digitalWrite(ledPin_G, LOW):

21 delay(1000);

22 3

3 Program content explanation

1. Define the variables

1 int ledPin_R = 13:
2 int ledPin_Y = 1Z;
3 int ledPin_G = 11;

We define three variables in this part, namely, 'ledPin_R’, 'ledPin_Y" and 'ledPin_G. The three variables
store the integers 13, 12 and 11 respectively.

2. Define the pins for the LEDs

SEvoid setup(d {

B pinMode(ledPin_R, OQUTPUTD;
Fi pinMode(ledPin_Y, OUTPUTD;
8 pinMode(ledPin_G, OUTPUT);
9 1

In the second part, we define the pins of the Arduino to which the LEDs will connect. We use '‘pinMode()'
to define pins 11, 12 and 13 as the output pins.
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3. Set the blinking sequence and frequencies of the LEDs

11Eveid loop() £
12 digitalWrite(ledPin_R, HIGH);
13 delay(1968a) ;
14 digitalWrite(ledPin_R, LOW);
15 digitalWrite(ledPin_Y, HIGH);
1€ delay( 10667,
17 digitalWrite{ledPin_Y, LOW);
18 digitalWrite{ledPin_G, HIGH);
19 delay( 106867 ;

28 digitalWrite(ledPin_G, LOW);
21 delaoy( 10686 ;
22}

The sequence for the LEDs to blink depends on the colours of the LEDs and is set to be in the order of
red, yellow and green. The duration for each LED to light up is one second. When an LED is turned on,
the LED that turns on previously will turn off. We use 'delay(1000)' to control the on and off duration
of the LEDs, and 'digitalWrite()' to control the order in which the LEDs are turned on and off.

VI1I.Review questions

1. Whatisan LED?
2. What are pinMode, int x = 3;?
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Chapter 5: Control (II) — Buzzer
I.  Sound-producing objects and sound

In addition to emitting light, it is also common for
electronic software to generate sounds. Sound-
producing objects can generally be categorised
into two types: speaker and buzzer. A buzzer is
small and flexible. However, since its sound
quality is poorer, it is more suitable to be used in
alarm devices or devices that produce sounds for
drawing attention. A small speaker is larger than

a buzzer. Making use of the vibration of a paper
film, the sound quality of speakers is higher than
that of buzzers. Therefore, speakers are more
suitable for electronic products that need to
produce precise pitches such as robots, electronic
keyboards and mechanical assistants. The
following diagram shows a buzzer.

The main component of a buzzer is the diaphragm.

The diaphragm consists of a thin copper plate.
When a current is applied, electromagnetic force
will be produced to make the copper plate vibrate.
Sound is caused by vibration, and the frequency
of the vibration is called audio frequency. With a

I1. Pitch and beat

The level of audio frequency is called pitch. In
music, we use Do, Re, Mi and other phonetic
names to represent pitches of various frequencies.
The keyboard on a piano is arranged according to
the audio frequency, in the order of musical scales

formula, we can find out the notes on
conventional music scale that various audio
frequencies refer to. Before writing a music
program, let's review some fundamental music
knowledge.

such as C, D and E. The frequency of a specific
pitch is exactly twice of that in the previous
octave (note: the 8th white key to the right of the
middle C 'Do' is the 'Do’ an octave above middle
C 'Do)).

is a standard of vibration measurement. Sound is a
waveform and each sound has its specific frequency. The
sharper the sound, the higher the frequency; the deeper the

sound, the lower the frequency.

é One Millisecond Duralion

Low freguency |:|1;¢Z¢E:ﬂm /—\ /\U/\\/ Deeper sound

itar) U

High frequency | shpe UBUOUDUGUDUDUDU&
‘Whistle)

Sharper sound
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AD# 29135
C1# 34648
D1# 28.891
F1# 456.249
Gi# 51.912
At# 58270
C2# 63.296
D2# 77.782
F2# 92499
G2# 10383
A2# 11654
C3# 12859
D3# 155.56
G3# 207865
Ae 23308
C4# 277.18
D4# 311.12

F3# 185.00

32703
36708
41.208
42654
489%
55.000

61735

B - -

B0 30868

c
D

E
C2 65406

A 275

D2 73416
E2 82407
F2 87307
G3 1%.00
A3 220.00
B3 246.94
C4 26162
D4 29366
E4 32062
F4 24823

- .

B

F4# 269.99

G4# 41530
Ad# 46616
CSe 55437
DS# 62225
F5¢ 73999
G5# 83061
AS# 83233
Cé# 11087
D6# 12445
F6# 14800
G6# 1661.2
AS# 18647
C7# 22175
D7# 2485.0
G7# 1224
AT# 37233

F7# 2960.0

e
FrvRe-e e

G4 3%2.00
A4 440.00
B4 439388
C5 523.25
DS 587.33
ES 659.25
F5 698.46
G5 78.9
AS 880.00
BS 987.77
E7 26370
F7 27938
G7 21360
A7 35200
B7 39511
C8 4186.0

Middle C

The task in this chapter is to use new syntax to control a buzzer, including ‘for' loop and array.

I11. *for' loop

To get started, let's understand the syntax of a ‘for' loop:

for (initial variable; conditional statement; count statement) {

statement 1;

statement 2;

When setting the loop, the first thing we should
decide is exactly how many times we want the
loop to repeat. Suppose we want to repeat three
times, example: for (byte i =0 ; i < 3 ;
i++) { }. Inthe first loop, the variable i has a
value of zero. When the first loop is executed
completely, the variable i will increase by one
and the second loop will be executed. Finally, the
variable i will increase by one again and the third
loop will be executed. As i needs to be smaller
than 3, the loop stops after the third loop is
completed.

From the loop syntax, we know that there are four
parts we need to set in a ‘for' loop. The first thing
is to write ‘for'. Then we need to set the initial
value of the variable, which is usually set as 0.
After representing the variable, we need to set the
execution condition. In the example, we set the
condition that the variable is smaller than 3, so
that the loop can repeat three times. Finally, we
need to set the method for determining the

Basic Unit 1: Basic control of electronic components

number of repetition. We know that if the variable
is equal to 3, the loop will stop. If the variable is
incremented by one each time, a total of 3 times
will be run from 0 to 3. So we set the variable to
be incremented by one each time. Eventually,
write the program we need to execute repeatedly
to finish the loop.

In the previous paragraph, we mention that the
initial value is usually set as 0, but there are
exceptions, for example, when we want to define
the LEDs connected to pin 8 to pin 10 in turn. We
can define the pins as output in the program, then
we can use variable i to handle the logic. During
the process, the pin number to be defined is
incremented each time starting from 8 and ending
at 10. In the first run, the variable is 8; in the
second run, the variable becomes 9; in the third
run, the variable becomes 10. In this way, we can
reduce the size of the program and avoid repeating
the same program codes.
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void setup() {

for ((byte i =8 ; i <=10 ; i++ ) {

pinMode ( i, OUTPUT );

IV. Array

Before discussing array, let's first find out how a
variable stores a value. In this part, we can think
of variable as a box. To define a variable, we are
giving a name to the box. Suppose an undefined
variable is an empty box.  After we define it, the
box will store a value. In normal circumstances,
one of these boxes can store only one value. If we
need to store 10 values in a program, we need to

write 10 statements; if we need to store 100
variables, we need to declare 100 times. Such a
program is very inefficient. To handle such
situations, we can use an array, i.e. to define a
certain amount of similar boxes in one time. For
instance, the following syntax means that the box
can store 4 integers.

int Nums[4]; (data type array name[array size] ;)

Nums

[e]

[1]

[2] [3]

Basic Unit 1: Basic control of electronic components
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V. Do ityourself — Buzzer

In this chapter, we will try to use Arduino to control a buzzer to play music. The task consists of two

parts: connecting the Arduino and the buzzer, and programming the Arduino to play music with the
buzzer.

1 Connecting the Arduino and the buzzer

We connect the buzzer and the Arduino as follows.

The way to connect the buzzer to the Arduino is  anode and cathode are usually marked with a red
very simple and straightforward. As the buzzer  wire and a black wire respectively. We need to
has high resistance itself, no extra electronic  connect the anode and cathode of the buzzer to pin
component is required when using the buzzer. 11 and GND of the Arduino respectively.

The buzzer also has an anode and a cathode. The
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2 Programming the Arduino to play music with the buzzer

Open Arduino IDE and connect the Arduino to the computer. Select Arduino UNO as the development
board in the Tools menu and check whether the Communications Port is connected to the Arduino
already. After connecting the Arduino, we need to input the following program and upload it to the
Arduino.

The complete music playing program codes. Refer to file 1 5 play music.

int buzzerPin = 11;

2 int notes length . .

3 char notes[] = ddedgfddedugddﬂbgfe[[bgug"' Define the variables and
4Eint beats[] = {1, 1, 2, 2, 2, 4, 1, 1, 2, 2, 2, 4, arrays

5 1,1,2,2,2,2,2,1,1, 2, 2, 2, 4};

B int tempo = 308;

7
8

98 wvold playTone(int frequency, int duration){
18 tone(buzzerPin, frequency);
11 delay(duration);
12 noTone(buzzerPin);
13 }
-; Define the functions
16Evolid playMote(char note, int duration){
17 char names[] = {'c', 'd', 'e', "f', 'g", 'a', 'b"', 'C", 'D'};

18 int freq[] = {261, 294, 329, 370, 392, 440, 493, 523, 587};
198 for(int 1 = @; 1 < notes_length; i++3{
203 if (names[i] == notel{

21 playTone(freq[i], duration};

22 }

23 |}

24 }

25
Zogvoid setup() {

27 pinModeCbuzzerPin,OUTPUT); Define the pin for the buzzer
728 }

29 O N NN BN NN NN NN SN SN NN BN SE NN BN BN NN NN BN RSN NN BN SN SN NN BN SN NN SN SN NN NN BN SN SN SN S SN S
38gvoid loop() {

318 for(int 1 = @; 1 < notes_length; i++3{

328 if(notes[i] == ' "{

33 delay{(beats[1] * tempo));

;;E‘ LSE{ Use a loop to play

36 playNote(notes[i], beats[i] * tempo); the song

37 }

38 delay(tempo/2);

39}

48 delay(1008):

P

-+
F

}
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3 Program content explanation

1. Define the variables and arrays

1 1int buzzerPin = 11;
2 int notes_length = 25;

char notes[] = "ddedgfddedagddibgfeCCbgag”;
4E1int beats[] = {1, 1, 2, 2, 2, 4, 1, 1, 2, 2, 2, 4,
Z,

51,1, 2,2, 2 2, 1,1, 2, 2, 2, 4};
3

£ int tempo = 368,

We define three variables and two arrays in this
part. The three variables are ‘buzzerPin’,
'notes_length' and ‘tempo’. 'buzzerPin’ stores an
integer of 11, representing the pin number of the
Arduino to which the buzzer is connected.
'notes_length' stores an integer of 25, representing
the total number of notes in the song. ‘'tempo’
stores an integer of 300, representing the length of

2. Define the functions

a beat. The two arrays are 'notes[]' and 'beats][]".
'notes[]' stores different English letters, which
represent the notes in the song. ‘beats[]" stores
the lengths of the notes. When the value of the
tempo is multiplied by each item in the array
beats[], the result obtained is the time each note is
played.

igvolid playTone(int frequency, int duration){

14 tone(buzzerPin, frequency);
11 deloy(duration);

12 nhoTone(buzzerPind;

13 }

l6Evold playMote{char note, int duration}{

17 char names[] = {'c', 'd', 'e', 'f'

18 int freq[] = {261, 294, 329, 37@, 392, 44@, 493, 523, 587};
193  for{int i = @; 1 < notes_length; i++){

203 if (hames[i] == noted{
21 playTone{freq[i], duration);

We define two functions, namely ‘playTone()' and
‘playNote()', in this part. Function ‘playNote()" is
responsible for setting the frequency of each note
according to the English letters in array 'notes[]".
Function 'playTone()' is responsible for playing
the song. Using ‘tone()’, we can play the song with
the buzzer connected to the pin defined in

3. Define the pin for the buzzer

Z6Evoid setup) {
27 pinModelbuzzerPin, OUTFUT);
28 }

D'}

ﬂI: |h|: ||::|:

'buzzerPin' according to the frequencies
calculated in function ‘playNote()’; using
'noTone()', we can stop the buzzer from playing
the song. In the for' loop, the number of loops is
set according to the length of the song, and the
song is played according to the length of the
music scales.

In this part, we use ‘pinMode()' to define pin 11 set in 'buzzerPin' as the output pin.

Basic Unit 1: Basic control of electronic components
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4. Use a loop to play the song

3vgvoid loop() {
318 for(int 1 = @; 1 < notes_length; i++3{

32E if{notes[1] = ' 'J{

delay((beats[i] * tempol);

35H elsef

3 playMote(notes[i], beats[i] * tempo);
37 }

delay(tempos2);

39 ¥

48 deloy( 1006 ;

41 }

In the fourth part, we use a 'for' loop from 0 to 25
to play all the notes defined in 'notes[]' once in the
program. There is an if-else condition set in this
loop. The if condition is to check whether there
are blank spaces in array 'notes[]". If a blank space
occurs, the program will treat it as a rest; if it is

V1. Review guestions

1. What is a ‘for' loop?

2. What is an array?

3. What is a buzzer?

4. What are tone(), noTone()?

Basic Unit 1: Basic control of electronic components

not a blank space, the program will treat it as a
normal note. At the end of the program, there is a
waiting of 'delay(1000), which functions as a
pause between songs, making it easier for us to
listen to the song.
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Chapter 6: Control (lll) - Motor

I.  Understanding direct current (DC) motors

Rotational shaft

There are many types of motors. The one used in
this chapter is the DC motor, also known as the
yellow motor. The indispensable parts of a
motor include a permanent magnet and a coil. A
magnetic field will be generated when power is
supplied to the coil, and the permanent magnet in

There are only two connections on a yellow motor
or a DC motor, one for power supply and the other
for connecting to the ground. However, the servo
motor we will user later, which provides high
stability, may have four to six connection wires
for setting the number of turns or angle of rotation
of the motor. Such highly precise operations are
typically used for industrial control, such as
robotic arms and photocopiers.

Basic Unit 1: Basic control of electronic components

Permanent
magnet

the middle will rotate according to the magnetic
field. The same current will cause the motor to
turn in the same direction, allowing the motor to
rotate. Following this logic, if the power supply
is connected in reverse, the motor will rotate in
the reverse direction.

Except electrical appliances such as electric fans,
hair dryers and power drills that connect the
motor to the load (example: fan blades) directly,
most power devices use mechanical systems such
as gearboxes and pulleys to reduce the motor
speed or convert the direction of the power output
to increase the torque.
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The H-bridge motor control circuit for controlling the forward and backward rotation of

a motor

Dr

——

f

|

From the introduction of motors above, we
understand that if we want to reverse the rotation
direction of a motor, we need to reverse the flow
of the current. However, in real situations, we
cannot control a robot in this way. Therefore, we
need to have an additional motor driver attached
to the motor for changing the rotation direction of
the motor. This motor driver is known as an H-

Do it yourself — Motor control

This chapter expects students to complete a task
for controlling a motor. Generally speaking, to
control a motor, a motor driver is required. A
motor has two rotation directions: clockwise and
anticlockwise, which correspond to different

Basic Unit 1: Basic control of electronic components

bridge motor controller. With this control method,
we can see from the above figure that the motor is
surrounded by four switches. The operation
method is as follows: in the first condition, when
switches 2 and 3 are closed, the motor will have a
leftward rotation; in the second condition, when
switches 1 and 4 are closed, the motor will have a
rightward rotation.

directions of current flow respectively. Therefore,
if we want to program the motor to rotate in a
clockwise or anticlockwise direction to achieve
the task, we must use a motor driver.
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1 Connecting the Arduino, the DC motor and the motor driver

We connect the Arduino, the DC motor and the motor driver as follows.

Motor 1

ENA IN1T IN2 IN3 IN4 ENB

Enlarged view of the motor driver

2 Programming the Arduino to operate the motor with the motor driver

Open Arduino IDE and connect the Arduino to the computer. Select Arduino UNO as the development
board in the Tools menu and check whether the Communications Port is connected to the Arduino
already. After connecting the Arduino, we need to input the following program and upload it to the
Arduino.
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The complete dual DC motor program codes. Refer to file1 6 two dc_motor.

1 F/Motora

2 const int motorENA = 18;

i const int motorINl = 9;

4 const int motorINZ = 8; Define the
5

6 //MotorB pins

7 const int motorENE = 5;

& const int motorIN3 = 7;

9 const int motorIN4 = 6;

I S ———

11E8void setup(}{
12 pinMode{motorENA, OUTPUTY);

13 pinMode{motorINl, OUTPUT);

14 pinMode{motorINZ, OUTPUTY); Define the pin
15 pinMode{motorENB, OUTPUTY); efine the pins
16 pinMode(motorING, OUTPUTY: as output

17 pinMode{motorINg, OUTPUTY);

182 }

T o o o o o o ——— ——— ——— ———

08 vord loop(){

21 motorForward(};
22 delay (20087 ;

23 motorBackward();
24 delay (20087 ;

25 motorstop();

26 deloy(10087%;

27 [}

2 m m ————— R R

J9Evord motorStop(d{

Main program

g digitalWrite(motorENA, HIGH);
3l digitalWrite(motorINL, LOW);
iz digitalWrite(motorINZ, LOW);
i3 digitalWrite(motorENE, HIGH);
34 digitalWrite(motorINI, LOW);
i5 digitalWrite(motorINg, LOW);
6 }

37

FEEvord motorForward(){

349 digitalWrite{motorENA, HIGH);

48 digitalWrite(motorINL, HIGH);

41 digitalWrite(motorINZ, LOW); The control

47 digitalWrite(motorENE, HIGH); Iogic on the
43 digitalWrite(motorIN3, HIGH); .

44 digitalWrite(motorINg, LOW); motor driver
45 }

46

47 Elvoid motorBackward(){

48 digitalWrite(motorENA, HIGH);
449 digitalWrite(motorINL, LOW);
28 digitalWrite(motorINZ, HIGH);
51 digitalWrite(motorENB, HIGH);
52 digitalWrite(motorINI, LOW);
53 digitalWrite(motorINg, HIGH);
54 }
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3 Program content explanation
1. The first part defines the pins, allowing us to write the program promptly.

1 F/Motaora
£ const int motorEMA = 18;
3 const int motorIWNl = 9;

const int motorINZ = &

B /MotorB

7 const int motorENBE = 5;
& const int motorIN3 = 7;
4 const int motorINd = 6;

2. The second part sets the working mode of the pins, which in this case is for communicating with
the motor driver. The Arduino UNO sends data to the motor driver, so the pin modes are set as

output.

118 void setup(}{

17 pinMode(motorENA, OUTPUTY);
13 pinMode{motorINl, OUTPUT);
14 pinMode(motorINZ, OUTPUTY);
15 pinMode(motorENE, OUTPUTY);
16 pinMode{motorIN3, OUTPUTY);
17 pinMode(motorING, OUTPUTY);
18 }

3. The repeating part instructs the motor to move forwards for two seconds, move backwards for two
seconds and then stop for one second. Then the whole action is repeated.

0B vord loop(D{

21 motorForward();
22 delay( 20087 ;
23 motorBackward(;

24 delay(2008%;
25 motorStop(;
il s delay(1008%;
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These codes define the actions according to the signals received by the motor driver. For example, when
all IN1, IN2, IN3 and IN4 are at low voltage, the motor will be stopped.

8 wvord motorStop 3

ia digitalWrite(motorENA, HIGH);
31 digitalWrite(motorINL, LOW);
iz digitalWrite(motorINZ, LOW);
i3 digitalWrite(motorENE, HIGH);
34 digitalWrite(motorIN3, LOW);
i5 digitalWrite(motorING, LOW);
e }

r]
i

JEEvord motorForward}{

3

39 digitalWrite(motorENA, HIGH);
48 digitalWrite(motorINl, HIGH);
41 digitalWrite(motorINZ, LOW);
47 digitalWrite(motorENE, HIGH);
43 digitalWrite(motorIN3, HIGH);
44 digitalWrite(motorINg, LOW);
45 1}

46

A7Evord motorBackward(){

48 digitalWrite(motorENA, HIGH);
49 digitalWrite(motorINL, LOW);
58 digitalWrite(motorINZ, HIGH);
51 digitalWrite(motorENE, HIGH);
BE digitalWrite(motorIN3, LOW);
53 digitalWrite(motorINd, HIGH);
54}

IV. Review questions

1. What is a DC motor?
2. What is an H-bridge motor control?
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Chapter 7: Unit Project — Lie Detector

Robotics covers a range of elements, including
science, technology and engineering. When
conducting the unit project, students need to apply
knowledge of various disciplines. For example,
firstly, you should start with scientific research,
studying the principle of electric current and the
characteristics of human skin, and then find out
how to use science to judge whether a person is
lying. Secondly, you should consider the design
of the robot by using the electronic components

Stage / step of

engineering Relevant knowledge

Investigation and design

learned in Unit 1. When the prototype is
completed, testing should be carried out. Finally,
you should improve your design based on the test
results. Throughout the project, students are
expected to acquire more knowledge on science
and engineering. It is also hoped that students can
improve their communication, problem solving
and leadership skills through collaboration with
the others.

Applying the relevant

considerations SIHIESSE

design
Define the Understand the working
problem principle of lie detectors and

refer to the standards used
by current or previous lie
detectors

(confirm the
requirements
and limitations)

Determine the design
requirements and limitations

investigation results

consideration processor of this

experiment
- Use analogue signals to

- Use LEDs and a buzzer to
show the responses of the
person when he/she is
being asked questions

Research - The principle of electric | Select a handling method (for
current and the different | example, if carried out in the
conductivity of materials | class, may choose one or more

- Conductivity of human | items, depending on the
skin teaching aims, lesson time and

- Effect of emotions, limitations on materials)
environments and weather /
on skin conductivity (e.g.
tension causes a decrease
in skin conductivity)

- Methods for measuring
skin conductivity

Design - Choose Arduino as the Prediction: Test with the Arduino first

When lying, the conductivity of
the skin is reduced due to
tension.
measure skin conductivity | effectively measure the changes
in skin conductivity

Analogue signals can

- Factors that affect skin
conductivity include
human perspiration,
environmental humidity
and emotions

- Design a circuit diagram
to measure the skin

Testing model

Assume emotion is the major
factor that affects the
conductivity of human skin.
Conduct fair tests for the
remaining variables one by one
to verify the impact of each
variable on the effect
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conductivity according to
the voltage divider rule
(potential divider)

- Use ared LED, a green
LED and a buzzer to
show the responses of the
subject when being asked
guestions

- Use a blue LED to show
the contact condition of
the lie detector

- Use a positioning tool to
reduce the error when the
lie detector is used on
different people

Fair tests:

To find out how human

perspiration affects skin

conductivity

* Independent variable: the
amount of perspiration of the
human body

- Dependent variable: skin
conductivity

- Control variables: exercise
volume, body temperature,
metabolism, etc.

To find out how different

environmental humidity affects

skin conductivity

+ Independent variable:
environmental humidity

- Dependent variable: skin
conductivity

- Control variables:
temperature, weather,
ventilation, etc.

Solve problems
encountered
during the
design /
production /
testing
processes

The testing process shows
that to get better results and
more accurate measurement:

- the subject needs to be in
contact with the lie
detector constantly when
he/she is being asked
guestions

- adjust the position of the
lie detector with the
positioning tool for each
user before use

- conduct the test at a place
with good ventilation
equipment

Regard these findings as the
necessary procedures for the
current engineering design

Analyse and
evaluate test
results and
problems
occurred

- The linear relationship
between voltage and
resistance [Ohm's law]
(engineering knowledge)

- The accuracy of the lie
detector

- Analyse data using Ohm's
law to assess whether the
design has achieved its stated
objectives

- According to the test results,
evaluate whether Ohm's law
is the key to success of the lie
detector

- Measuring the skin
conductivity as the only
condition for lie detection
gives inaccurate results

Based on the analysis and
evaluation results, find out
ways for improving the
design

Basic Unit 1: Basic control of electronic components

40




1 Circuit making of the lie detector

We set up the circuit of the lie detector as follows:

2 Exterior design of the lie detector

Students can design and make the housings for the lie detectors based on their own ideas to protect the
Arduino boards and other electronic components. The following is a reference of the housing for the lie
detector made of cardboard.

5. 6. Reserve a space for the USB
port on the housing

<
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3 Programming the Arduino to make it work as a lie detector

Open Arduino IDE and connect the Arduino to the computer. Select Arduino UNO as the development
board in the Tools menu and check whether the Communications Port is connected to the Arduino
already. After connecting the Arduino, we need to input the following program and upload it to the
Arduino.

The complete program codes for the lie detector. Refer to file 1 7 lie detector.

1 const int red_led_pin = 9;

2 const int green_led_pin = 18;

3 const int blue_led_pin = 11; ) )

4 const int buzzer_pin = 73 Define the variables

5 const int offset_pin = 15;

b const int sensor_pin = 14;

7 1int band = 25;
e ———
9 wold setup() {

[s=]

pinMode(red_led_pin, OUTPUT);

11 pinMode(green_led_pin, OUTPUT};

12 pinMode(blue_led_pin, OUTPUT); Set the variables as output
13 pinMode(buzzer_pin, OUTPUT); and open the serial

14 pinModeloffset_pin, INPUT); .

15 pinMode(sensor_pin, INPUT); communication channel
16 Serial.begin(9608);
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13 SEEN BN SN SN SN SN SN SEEN NN SN SN SN BNEN SNEN NN SN SEEN SEEN SNEN NN SN SN SN SN BNEN NN SN SN SN BN BN B SN BN SN SN S S S S S .
19 void loop() {

20 1int offset = anologRead(offset_pin);

21 int value = analogRead(sensor_pin);

22 1f (walue = offset - band){

23 digitalWrite(red_led_pin, HIGH);

24 buzzer();

25 Serial.println("Lie test foil.");

1 ) Use the analogue input to
27 else if (value < offset - band){

28 digitallirite(blue_led_pin, HIGH); change the error value

29 Serial.printin{"Lie detector ready"}; and detect lies by

3; ilse{ measuring the amount of
32 digitalrite{green_led_pin, HIGH); water

33 Serial.println{"Lie test pass.");

EE.

i5 1

30 | o o o o o -
37 wold buzzer()4

38| for(int 1 =@; 1 < 1000; 1i++){

39 digitalWrite(buzzer_pin, HIGH);
43 delayMicroseconds(1087; -
41 digitallrite(buzzer_pin, LOW); When failing the test, the
42 delayMicroseconds(10@); buzzer sounds

43 1

44 1
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4 Operating principles

This lie detector assumes that the subject will sweat when lying, and sweating will change the
conductivity of the fingers slightly. Making use of this property, the Arduino can be programmed to
detect the changes when connected to the circuit, and make corresponding judgment. This is how this
lie detector works.

5 Program content explanation

1. Define the variables

const int red_led_pin = 9;
const int green_led_pin = 19;
const int blue_led_pin = 11;

P N

const int buzzer_pin = 7;
5 const int offset_pin = 15;
b const int sensor_pin = 14;

7 int band = 25;

In the first part, we define the variables. Firstly, the pin settings of the red, green and blue LEDs are 9,
10 and 11 respectively. We define pin 7 for the buzzer, and 14 and 15 for the two analogue pins. Finally,
we add the standard definition 25 obtained from testing.

2. Set the variables as output and open the serial communication channel

9 wold setup() {

18 pinMode(red_led_pin, OUTPUT);
pinMode(green_led_pin, OUTPUT);
pinMode(blue_led_pin, OUTFUT);
pinMode(buzzer_pin, OUTPUT);

14 pinModeloffset_pin, INPUT);
p
5

|
ad d =

5 inMode(sensor_pin, INPUT);

b erial.begin(9608);
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In the second part, we need to set the variables defined in the first part as output and input, such as the
red, green and blue LEDs, the buzzer and the two analogue pins. We will also open the serial
communication channel and set the transmission rate as 9600.
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Use the analogue input to change the error value and detect lies by measuring the amount of water

19 void loop() {

int offset = analogRead(offset_pin);

int value = analogRead(sensor_pin);

if (wvalue = offset - band){
digitalWrite(red_led_pin, HIGH};
buzzer();
Serial.println("Lie test fo1l.");

}

else if (value < offset - band){
digitalrite(blue_led_pin, HIGH);
Serial.println("Lie detector ready”);

}
elsef
digitalfirite{green_led_pin, HIGH);
Serial.println{"Lie test pass.™);
¥

In the third part, we first read the values from the two analogue input pins with the function
‘analogRead()'. If the values of the two contacts we obtain through the wires are larger than the pre-set
standard, we will turn on the red LED, sound the buzzer and print the line 'Lie detector fail.". If the values
do not exceed the pre-set standard, the line 'Lie detector ready' and finally 'Lie test pass.' will be printed.

4. When failing the test, the buzzer sounds

=17

49
a1
42
43
44

¥

7 wold buzzer(DL

for{int 1 = 0; 1 < 1000; 1+
digitalWriteCbuzzer_pin, HIGH);
deloyMicroseconds(1687;
digitalWrite(buzzer_pin, LOW);
deloyMicroseconds(1687;

I3

In the fourth part, we configure a function called 'buzzer()'. We create a loop that repeats for a thousand
times, turning on and off the buzzer continuously to simulate the sound of an alarm.
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